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Commands
File menu
Edit menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Exit Exits Mirage



Edit menu commands

The Edit menu offers the following commands:

Cut Deletes data from the document and moves it to the 
clipboard.

Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window Toggle Size command allows you to toggle the size of the currently active 
window
 within the set of four splitter windows in the main menu of Mirage. The contents of the 
currently active
window is red.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in Mirage.    

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

Start with a fresh Mirage .mrg document. The current document is removed from the 
program.



Open command (File menu)

Use this command to open an existing document in a new window.    

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

Drives
Select the drive in which Mirage stores the file that you want to open. 

Directories
Select the directory in which Mirage stores the file that you want to open.



Close command (File menu)

Use this command to close all windows containing the active document.    Mirage suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, Mirage displays the Save As dialog box and suggests that you name 
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, <<YourApp>> displays the Save As dialog box so 
you can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Mirage displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Mirage adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your Mirage session.    You can also use the Close command on the
application Control menu.    Mirage prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Mirage, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Mirage,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    Mirage displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, Mirage displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Mirage window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

Mirage displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Mirage and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of    
Mirage.



Context Help command 

Use the Context Help command to obtain help on some portion of Mirage.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Mirage window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Mirage window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Mirage determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Mirage determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Mirage window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)



Choose Font dialog box



Choose Color dialog box



Find command (Edit menu)



Find dialog box



Replace command (Edit menu)



Replace dialog box



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)



Clear All command (Edit menu)



Next Pane



Prev Pane



Modifying the Document





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



  Mirage Help Index

Main Menu Commands

File menu
View menu
Edit menu
Window menu
Rules menu
Display menu
Import menu
Export menu
Help menu

Graphics Menu Commands

Action menu
Edit menu
Color menu
Composite menu



 Rules menu commands
      
      The rules menu includes commands for managing the rules within the expert system.    For
      more information select the Rules menu command name :

        New
        Delete
        XChange Positions
        Position at end



 Rules New command

        This command is used to invoke the Rules New dialog box so that you can add new rules
        or replace existing invalid rules with newly created rules. For more information on how
        to use the Rules New dialog box    see the Mirage User's Manual Page 17.



 Rules Delete command

        This command is used to delete rules from the expert system. For information on how to
        delete rules see the Mirage User's Manual page 22.



 Rules Xchange Positions command
        
This command is used to exchange the positions of two rules within the rules list. During the 
course of data analysis, the rules are fired sequentially from low number to high number.
With this command, the rules can be positioned in whatever sequence is desired so that
 the proper sequence of firing is followed. For information on how to use this command,
see the Mirage User's Manual page 22.          



 Rules Positon at end command

        This command is used to position a rule at the end of the rules list so that it will fire last
        in the sequence. During the course of data analysis, the rules are fired sequentially from
        rule number 1 till the end of the rules list. If it is necessary to position a rule at the end
        so that it can perform some sort of a default process, use this command. For information
        on how to use this command, see the Mirage User's Manual page 21.
          



Display menu commands

        The display menu includes commands to create display variables, assign min. and max. values 
        for them, and modify these values. It also includes commands to manually map display variables
        to color values. The Display Graphics command is used to display the Mirage Graphics 
        Window. For more information, select the Display command name :

          Display Graphics
          Edit Display List
          Map Display Variable



 Display Graphics command

        The display graphics command is used to display the Mirage Graphics Window. You can also 
        use the rightmost bitmap button ( the one with the colored squares) in the ribbon to invoke this
        command. 



 Edit Display List command

        This command is used to add or delete display variables from the display variables list. The 
        display variables list ( lower left window of the main splitter window) contains a list of
        attributes from the data sheet and extra variables from the list of extra variables which,
        because they are now listed as display variables can now be analyzed in the Mirage 
        Graphics Window.



 Map Display Variable command

        This command is used to map a display variable to particular color values. For textual data types, 
        the mapping is performed by assigning particular textual values to color values ( up to 10 
        assignments per display variable). For numerical data types, the mapping is performed by
        assigning data intervals ( which lie between the min. and max. for the display variable) to
        color values. Up to 6 data intervals can be assigned per display variable. 

        To enable this command, click on the cell which contains the name of the display variable in
          the display variable window ( lower left of the main splitter window). Then select this
          command. 

        This command can also be used to view the mappings of a display variable. Simply click on
          the cell with the variable name in the display variables window, and then select this command.



 Import menu commands

        This command is used to import data tables in the data sheet ( upper left of the splitter window), 
        or to import a list of extra variables ( upper right of the splitter window). The imported file must    
      be a tab delimited ascii .txt file. Note that if the imported file contains more rows or columns than
      the cells in the data sheet ( 30 columns X 100 rows of data), then the data in the extra rows will
      be truncated. Ostensibly, the text file was created in a spreadsheet or a database. 

        For importing data tables, you have the option of importing just the data ( without the attribute
        names corresponding to the first row of information in the data table), or the data plus the
        attribute names. For importing extra variables, you have the option of importing the extra
        variables names column ( corresponding to the first column    in the extra variables window)
        plus the values ( corresponding to the second column in the extra variables window), or
        of importing just the values (second column).



    Export menu commands

          This command is used to export data tables in the data sheet (upper left of the splitter window),
            or to export a list of extra variables ( upper right of the splitter window). The file in which the
            data is exported to will be a tab delimited ascii .txt file. Ostensibly, the text file will be picked
            up into a spreadsheet or a database.
        
          For exporting data tables, you have the option of exporting just the data ( without the attribute
          names corresponding to the first row of information in the data table), or the data plus the
          attribute names. For exporting extra variables, you have the option of exporting the extra
          variables names column ( corresponding to the first column in the extra variables window)
          plus the values ( corresponding to the second column in the extra variables window), or
          of exporting just the values ( second column).



 Action commands

        These commands perform actions in the graphics window that either facilitate the data
        analysis or affect it in some way. For more information, select the Action commands :

          Go
          Replay Mode
          Disable Rules
    



Go command

        This command produces a color value for each of the active display variables and COMPOSITE
          windows as all the items in the control box ( corresponding to rows in the data table) are 
          sequentially traversed down the list. The color values pertaining to all the mini-windows are
          displayed as the analysis is being performed. Note that the color values are saved temporarily
          so that if you enter Action Replay Mode immediately (without performing any other actions)
          after this action, you can traverse back up or down the list using the two arrows in the scroll
          bar for the control box. 



Replay Mode command

      This command toggles the graphics window between replay mode and non-replay mode. During
        replay mode, which is entered immediately ( without performing any other actions) after the
        Go commmand, the color values need not be calculated as different control box items are 
        selected. Rather, they have already been saved due to the invocation of the Go command.
        This makes for much faster display changes in the mini-windows for the active display variables
        and the COMPOSITE windows. 

        Note that after entering replay mode, you should go to the control box and manipulate the up
        and down arrow keys of the scroll bar by depressing the left mouse button and keeping it
        depressed. You cannot move the shaft inside the scroll bar and expect the mini-windows
        to continuously update their colors. 



 Disable Rules command

        This command toggles between disabling and enabling rules during the course of data analysis.
        The default is that the rules are enabled. If the rules are disabled, Mirage will assume during the
        course of data analysis that no rules exist and will not attempt to fire them even if the rules list
        is not empty.



Edit commands

      The list of display variables which are currently active ( if they are active a mini-window is 
      created for them) can be modified by the Active Variables List command. In order to analyze
      the content of any particular attribute or extra variable, it must be activated. Note that
      if the graphics window starts to become congested, its size can be increased.

      The current control variable can be changed to any attribute from the data table. The default
      control variable is the first attribute ( left most column in the data table). The items contained
      in the control box are values from each row in the data table for the current control variable.



 Color commands

        During the course of analysis, the colors displayed in the mini-windows can be either from the
        RGB spectrum or display a gray scale. 

        For the RGB spectrum, a color value of 0 (min. color value) corresponds to red and a color value
        of 255 (max. color value) corresponds to blue. A color value of 127 or so ( in the middle of the
        spectrum)    should display a green. 

        For the gray scale, a color value of 0 corresponds to white and a color value of 255
        corresponds to black.



 Composite Windows

        Composite windows are windows which display a color based upon the color values of separate
        components (    each component being an attribute or an extra variable) with each component
        being assigned a specific percentage weight. The combination of all the percentages which make
        up the weights should sum up to 100 percent.    
        
        Note that all composite windows are destroyed    if any display variable is deleted from the display       
        variables list. If Mirage is about to delete any display variable ( during the invocation of the 
        Display - Edit Display List dialog in the main menu ) and the graphics window currently has      
        active composite windows, the user is notified if he wants to continue with the deletion of the 
        display variable. For more information about Composite Windows, see :
    
        Create
        Modify
        View
        Delete



Create Composite Window

        This command creates one of a maximum of three composite windows. The composition of the
        composite window is defined in the dialog box which is invoked by this command. Note that 
        you can always change the composition of the window ( both the display variables included
        in the makeup and also the individual percentages) later by invoking the Modify command.



Modify Composite Window

      This command invokes the same dialog box that was used to create the composite window.
        Any changes made must insure that the percentages add up to 100%.



 View Composite Window

        This command invokes a small window which displays the display variables comprising the
        makeup of the composite window along with its corresponding weights.



 Delete Composite Window

        This command deletes the composite window so that the mini-window is removed and all
        information related to its makeup is deleted.



 Edit Display Variables dialog

This dialog is used to add or delete entires in the display variables list. The list is comprised of data
sheet attributes ( data column names) and Extra Variable Names. If you want to redefine the
min. or max. for a display variable, delete it from the list, and then add it again so that you are
prompted to again specify the min. and max. 
Options
              Add
              Delete



Add

Select an attribute or extra variable from the Data Column Names or the Extra Variable Names and then 
click on Add to include it into the Display Variables List.



Delete

Select a display variable from the Display Variables List and then click on Delete to remove it.    



        
Map Text Display Variable
    
    This dialog is used to map display variables whose data type is textual to corresponding
      color values.    Up to ten different textual values can be entered for the variable. Start
      from the first row in the Text Value column, press the Tab key, enter the color value
      in the Corresponding Color Value column, and again press the Tab key to continue
      entering mapping information into the two columns until finished.

        Options
              Default color value              Min. color value              Max. color value



 Default color value

        Enter the color value that will be assigned to the display variable if the text from the data
        sheet does not match any of the entries specified in the Text Value column.



 Min. color value

        The minimum color value of the display variable is always 0. The edit box is read only.



 Max. color value

        The maximum color value of the display variable is always 255. The edit box is read only.



 Edit Active Display Variables List

      This dialog box is used to activate and deactivate display variables. An activated display
      variable is one which has a mini-window in the graphics window. The mini-window 
      displays the color corresponding to a particular color value during an instance of data
      analysis. Click on entries in the list box to select or deselect a display variable and then
      select OK. 



 Interval Setup Dialog

        After clicking on the Mapping Mode button to go from automatic to manual, you will
        be prompted with a series of this dialog box until you specify the Max. value for interval
        to be equal to the max. data value for the display variable. 
        
      The min. for the first interval is the min. data value for the display variable. The max.
      for each interval is entered into the top edit box.    For the next sequence in the series of 
      invocations for this dialog box, the min. for the corresponding interval is the max. from the
      previous interval plus 1. 

      Enter the corresponding color value for the interval in the lower edit box.



    
    This dialog is used to enter the min. and max. data values for a display variable of numeric
    data type. The min. data value will map to a color value of 0 in the mini-window for this display 
    variable. The max. data value will map to a color value of 255. If the data falls below the
    min. data value, the mini-window displays black stripes. If the data falls above the max. data
    value, the mini-window displays red stripes.



 View Invalid Data Columns

    The data columns in the list box contain inconsistent data types. For any particular data column
      in the data sheet, all data must either be of type float, integer, or text. Any numerical value with
      a decimal point is considered to be of type float. 
      View the data in these columns and edit the cells so that all data is of one type.
      Note that invalid data columns are not detected until you are about to perform data analysis
      in the graphics window.



 View Invalid Rules
        
        The rules listed in the list box attempt to compare entities of different data types.
        If you are comparing two entities in the IF CLAUSE or setting one entity to
        be equal to another entity in the THEN CLAUSE, both of the entities involved
        must be of the same data type.

          If there are invalid rules in the list, then invoke the Rules New dialog box. At
          the bottom of the dialog box, there is a list box which contains the list of invalid
          rules. Enter a new rule as you normally would, then instead of clicking on OK or
          Next Rule, select a rule from the invalid rules list and then click on Replace.

          Instead of invoking the Rules New dialog box, you can also delete the invalid
          rule from the rules list at any time.



 View Invalid Mappings

        The display variables listed in the list box are mapped inappropriately with respect to
        their data types. Either a textual type of display variable has been mapped as numeric
        or vice versa. This can occur if the extra variable or attribute data type has been 
        changed since the mapping was originated. In this case you need to invoke the
        Edit Display Variables List dialog, delete the display variable in question, and then
        add it again. Mirage will detect the current data type for this display variable and
        invoke the appropriate mapping dialog. 



 Edit Composite Strength List

        Use this dialog box to create the makeup for each of the three COMPOSITE
        windows. Select a display variable from the upper left list box and then click on
        Add. You will be prompted to specify a percentage strength for the variable.
 
        If there is a need to change the weight of a variable in the makeup list, then first
        remove it from the list and then add it again. This will enable you to re-enter a new
        weight for the variable.

        To remove a variable from the makeup list, select it from the lower right list box
        and then click on Remove. Note that you will have to reassign the weights of the
        other variables in the list so that they all add up to 100%. 



 Select New Control Variable

        The list box in this dialog contains the list of attributes from the data sheet. The attribute                  
        value from each row in the data sheet will be displayed in the control box. Note that the
        default control variable is the first attribute ( first column ) in the data sheet. Select the
        attribute in the list box that is going to become the control variable and then click on OK.



 Specify data type for blank column

        The Edit Table Column Names command has been invoked on a column that has blank 
        data ( at least the first row of data is blank which is what Mirage checks for). Normally,
        this means that you are currently trying to expand the data sheet by one attribute. Make
        sure that the current column is the first blank column to the right of the data sheet table.
 
        Since a brand new attribute is about to be defined, Mirage needs to know the data type.
        The cells in that column will be filled with initial data according to the data type specified.
        This is done so because Mirage cannot accept blank data cells if in fact a new attribute
        is being added to the data table. 

        If the data type is numerical, the cells will be filled with 0s ( or 0.0s). If the data type is
        textual, the cells will be filled with the word "TEXT". Of course, you can modify these
        values at any time but the point is that they cannot be left blank. 



        
        

          




